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Support software

MEXEQ2 Version 3
OPERATING MANUAL

This Operating Manual describes product handling procedures and safety precautions.
e Please read it thoroughly to ensure safe operation.
o Always keep the manual where it is readily available.
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Introduction

1 Introduction

B Before Use

Perform any installation, uninstallation, editing, and other operations for the support software MEXEQ2 using an
account with Administrator privileges.

Use the MEXEOQ2 correctly and safely after thoroughly reading the manual and understanding the basic operating
procedures and other details.

B Applicable product

The MEXEO2 can be used with Oriental Motor's stepping motor drivers, servo motor drivers, brushless motor drivers,
and network converters etc.
A product that can be combined with the MEXEQ2 is described as "applicable product” here.

B Notation rules

The description of text in this manual follows the Menus and submenus shown in/from
notation rules s.pecifled as shown at the ri.ght. The. . the title bar, buttons, and other controls
screens shown in this manual are those displayed in that can be clicked with the mouse, are
Windows 7. The screens vary according to the operating enclosed in square brackets.

systems (OS) you will be using.
y 4 9 v Dialog box messages, etc., are enclosed in

double quotations marks.

Unless otherwise noted, this manual explains using screen examples of the AR Series FLEX AC power
input Built-in controller type.

B Functions of MEXEQ2

The MEXEOQ2 is a software program that lets you set data required for motor operation from a PC.
Data can be edited in various PC screens, or data set in an applicable product can be checked from a PC.
The key functions of the MEXEQ2 are explained below.

Functions, setting items, screens and others vary depending on the applicable product combined
with the MEXEOQ2. For the functions and operating methods that can be used, check the USER
MANUAL or OPERATING MANUAL AZ Series Function Edition of the applicable product.

® Editing and saving the data

Operation data and parameters can be created and edited.

Data edited in the MEXEQ2 can be written to an applicable product, or data stored in an applicable product can be
read into the MEXEO2.

You can save data files created in the MEXEOQ2 in either the MEXEQ2's dedicated file format or CSV format.

® Monitor function
You can monitor the product (motor and driver) status, motor operating status, ON/OFF status of I/0 signals, and
others.
The waveform monitor lets you check I/0 signals, motor speeds and other settings based on measured waveforms.
® Test function

e /O test can be performed to monitor input signals and cause output signals to be output forcibly.
e Test operation for the motor can be performed using the teaching/remote operation or remote operation.

B Support menu

The [Support] menu may be shown on the menu bar depending on the applicable product combined with the
MEXEO2. The update of firmware can be performed from the [Support] menu.

e The [Support] menu is not shown for all of the applicable products.
e The contents of the [Support] menu vary depending on the applicable product.
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H Installation and uninstallation of MEXEOQ2

For the installation and uninstallation of the MEXEQ2, refer to Oriental Motor Website.

Communication cables
Communication cables vary depending on the applicable product. Check the USER MANUAL or OPERATING MANUAL

Driver Edition of the applicable product.
When using a USB cable

Use a commercially available USB cable.

When using our CCO5IF-USB communication cable for the support software

Our communication cable for support software CCO5IF-USB is a set of two cables, a PC interface cable and a USB
cable. Purchase it separately.

System requirements

The installation of the MEXEQ2 on a PC requires one of the following operating systems (OS) and a PC compatible
with the OS you will be using. For the Operating environment with MEXEOQ2 version 3, check on the Oriental Motor
Website.
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Safety precautions

Safety precautions

The MEXEOQ2 is designed on the assumption that the user has an understanding of basic operations such as starting
up and exiting applications in Windows and how to use a mouse. Use the product only after carefully reading and
fully understanding these instructions.

Also read the "Safety precautions" section in the USER MANUAL or OPERATING MANUAL Driver Edition for the product
to be used in combination with the MEXEQ2.

Handling the product without observing the instructions that accompany a "WARNING" symbol may result in serious
injury or death.

Connection

o Turn off the power to both the PC and applicable product before connecting your PC to the applicable product.
Failure to follow this instruction may cause electric shock.

Handling the product without observing the instructions that accompany a "CAUTION" symbol may result in injury or
property damage.
Connection

e The data setter connector or USB connector of the applicable product is not insulated. When grounding the
positive terminal of the power supply, do not connect any equipment (PC, etc.) whose negative terminal is
grounded. Doing so may cause the equipment and applicable product to short, damaging both. Do not ground
the equipment if you plan to connect it.

Disposal
e Dispose the product correctly in accordance with laws and regulations, or instructions of local governments.
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3  Startup and shutdown

This chapter explains how to start up and shut down the MEXEQ2.

3-1 Starting the MEXEO2

Double-click the MEXEOQ2 icon on the desktop to start the MEXEQ2.
The following window (launcher) appears.

MEXED2
Eneglish
Edition

3-2 Shutting down

Click [Exit] from the [File] menu. Alternatively, click the button on the upper right of the screen.

The MEXEO2 shuts down.

1
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Startup and shutdown

Checking version information

You can check the version of the MEXEO2 software you are using.
1. Click [About MEXEOQ2] from the [Help] menu.

2. After you have checked the software version, click
[Close].
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4  Connection with MEXEO2 and
applicable products

This chapter explains how to prepare to start communication with the MEXEQ2, and how to check the connected
product.

4-1 Connection with applicable product

1. Connect the PCin which the MEXEQ2 has been installed and an applicable product.
Read the USER MANUAL or OPERATING MANUAL Driver Edition of the applicable product to connect it correctly.
Refer to p.4 for the communication cable.

2. Turn on the power to the applicable product.

4-2 Setting of communication port

When connecting the PC and applicable product, the communication port is required to set.

1. Click [Setting of the communication] on the launcher.

2. Select the port to which the applicable product is connected and click
[OK].
When connecting using the USB cable: "ORIENTAL MOTOR/common
virtual COM port" is displayed.
When connecting using the CCO5IF-USB: "ORIENTAL MOTOR/virtual
COM port" is displayed.

% Before setting the communication port, make sure to connect the PC and applicable product and
turn on the power of the applicable product. Without proper connection, the connection port will
not be displayed.
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4-3 Checking the connected product

1. Click [Device information] on the launcher.

2. Click [Check].

The check on the connected product starts. :

3. When the results are displayed, click [Close].

® When the series name or product name (mode) of the applicable product is not displayed.

Verify the following points:
e Is the applicable product powered on?
e Is the cable completely inserted?
e Is the connected product compatible with the MEXEQ2?

® When "Unsupported product" is shown in the product name column.
Verify that the connected product is compatible with the MEXEQ2.
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5 Methods for creating new data and
editing data

This chapter explains how to create data files, edit operation data and parameters, and store edited data.

5-1 Creating new data

1. Click [New] on the launcher.

2. Select the model with any of the following
methods.

(@ Click [Product automatic selection]. @
The connected product is automatically

selected. @

@ Select the model from the "Product series
list" "Product name (mode) list," and "Motor/
actuator.”

This is a method to select the model manually
from the products shown in the list.

B select the model from "Select from history."
This is a method to select the model manually
from "Select from history." @

In the case of actuators, select the series name of the motor that is equipped to the actuator.




3. Click [OK].
The data edit window appears.

Data edit window

Methods for creating new data and editing data
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B Description of edit window

[

This is used to select and execute a function.

Some of the functions available on the menu are provided as an array of icons.

This is used to select a group of data for editing.

Using these buttons, functions such as monitor and test can be executed. The
functions in this area can also be executed from the [Tool] menu.

This is an area to edit data. The display is changed by selecting a group from the tree
view.

B Explanation of functions

Functions, setting items, screens and others vary depending on the applicable product combined
with the MEXEOQ2. For the functions and operating methods that can be used, check the USER
MANUAL or OPERATING MANUAL AZ Series Function Edition of the applicable product.

This function lets you check how the motor will operate before actually
connecting it to a host controller. Operation data can also be set using
teaching function.

I+

Teaching remote operation

This function lets you check how the motor will operate before actually
connecting it to a host controller.

&

Remote operation

1/0 signals of direct I/0 and remote /O can be tested. Also, you can
monitor input signals and cause output signals to be output forcibly.
This function is convenient if you want to check the wire connection of
physical I/0 with the host controller and the operation of network 1/0.

1/0 test

%)

You can monitor the current status of an applicable product and the ON/
OFF status of I/0 signals.

All the I/0 signals of an applicable product can be monitored. You can
also check signals not assigned to direct I/0 or remote I/O.

Status, I/0 monitor

Internal I/O monitor

Remote I/0 monitor You can check the ON/OFF status of network I/O.

You can monitor the remote register status that can be read and written
to via a network.

|0 T =

Remote register monitor
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Name Icon Description

You can monitor the RS-485 communication status of an applicable
product.

B

RS-485 status monitor

You can monitor the data sent and received between an applicable

Remote monitor product and host controller.

The alarm records of up to ten most recent alarms starting from the latest
one can be checked. Also, with the AZ Series, the operation and the
status of I/0 signals, which were executed when the alarm generated, can
be checked.

The warning records of up to ten most recent warnings starting from the
latest one can be checked.

Alarm monitor

Warning monitor

The error records of up to ten most recent errors starting from the latest
one can be checked. Also, with the AZ Series, the received data via RS-
485 communication can be checked.

RS-485 communication
monitor

Waveform monitor The motor speeds and 1/0 signal status can be checked in waveforms.

You can adjust parameters while checking the motor speeds and 1/0

Gain tunin . 5
9 signal status in waveforms.

M| e e | s &

Launcher You can start the launcher.

5-2 Setting data in the data edit window

% Just changing the data in the MEXEOQ2 will not cause the data in the applicable product to change.
To change the data in the applicable product, writing data must be performed. Refer to p.18 for details.

Data cannot be edited while communicating with the applicable product using the monitor or test
function. Edit data after ending the communication.

B Data entry

The background color of a cell is initially white. When the value in the cell is changed, the color of the cell changes to
yellow.

The color of characters in the cell is initially blue. When the value in the cell is changed, the color of characters
changes to black.

@ Entering a numeric value

Click a desired cell, and enter a numeric value using the
keyboard.

® Selecting a value from a pull-down menu

Double-clicking a desired cell displays a pull-down menu.
Select a desired value from the pull-down menu.

® Entering characters

Click a cell and enter characters using the keyboard.

m Do not enter a comma (,) in the "Name" field of the operation data. Entering a comma may cause a
\_/\_/ . .
problem in the subsequent data edit.




Methods for creating new data and editing data

B Copying and pasting data

You can copy an entered value and paste it into a different cell. Copying and pasting lets you quickly populate
multiple cells with the same value.

1. Select the data you want to copy, and then click the [Copy] icon in the toolbar.
You can select a single value or multiple values.

O

B Data to be copied

2. Click the cell you want to paste the data into, and then click the [Paste] icon in the toolbar.

B Undoing and redoing

1. To undo the last edit that you made, click the [Undo] icon in the toolbar.

2. Toredo the last edit that was undone, click the [Redo] icon in the
toolbar.

e [Undo] operation cannot execute:

- When communicating with the applicable product
-When no edit has been done yet.

¢ [Redo] operation cannot execute:
-When no [Undo] has been done yet.

|14
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5-3 Saving a data file

The data edited within the MEXEQ2 or data read by the applicable product will be saved as a file.

Data files can be saved in the MEXEO2 format (.mx2), MEXEQ2 extended format (.mx2a), or CSV format (.csv). Data
files saved in the MEXEQ2 format and MEXEQ2 extended format cannot be opened in other applications. Save data
files in the CSV format if you want to open them in other applications.

M Saving data by overwriting

Click the [Save] icon in the toolbar.

The current data is saved over the existing data.
B Saving data under a different name

1. Click [Save as] from the [File] menu.

2. Enter a new file name, and click [Save].
The data is saved under the specified name.

1

m If the data, which has been saved in the MEXEOQ2 extended format (.mx2a), will be saved in the
MEXEO2 format (.mx2) again, the extended information will be erased. Be sure to check the saving
format (filename extension) beforehand.
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B Saving data in CSV format

Data saved in the CSV format can be edited in applications other than the MEXE0Q2.

Data files in the CSV format cannot be opened in the MEXEQ2. To edit in the MEXEQ2, open the file

in an application other than the MEXEQ2, and paste the data to the MEXEO2.

1. Click [Export] from the [File] menu.

2. Enter a file name, and click [Save].
All operation data and parameters are saved
in CSV format.

Data initialization

5-4

W Save As =)
) ) [[3 v Libraries » Documents » ~ |42 ][ Search Documents o]
Organize v New folder = @
¢ Favorites —~ Documents library T o

B Desktop Includes: 2locations
% Downloads || pame ’ Date modified Type Size
7l Recent Places
No items match your search.
4 Libraries
[ Documents
& Music
=] Pictures
B videos -
File name:  Newl -
Save as type: | CSV format (*.csv) v]

B Restoring the editing data to the default

You can initialize the data you have edited in the data edit window.

1. Click [Initialize] from the [Edit] menu.

2. Select the data you want to initialize, and click [OK].

3. Click [Yes].

The data being edited is returned to the default.

|16



Methods for creating new data and editing data

B Restoring only the value in the selected cell to the default

1. Select the cell to return to the default on the data edit window.

2. Click the right mouse button, and click [Initialize].
The value in the selected cell returns to the default.
The color of the cell remains as yellow. It does not return to white | ]
(initial state).

5-5 Ending data edit

To close the data edit window, click [Close] from the [File] menu.

5-6 Opening an existing data file
1. Click the [Open]icon in the toolbar. O
2. Select the file you want to edit, and click € open
[Open]. @O-@ » Libraries » Documents » ~ [ 43| [ Seorch Documents 3
The data edit window appears. grompe | Mewiolier =2
¢ Favorites = Documents library i B
B Desktop Includes: 2 locations -
% Downloads Name ’ Date modified Type Size
%] Recent Places
| Newl.mxZa 10/13/2015 2:42 PM MX2A File 154 KB
& Lib . New2.mx 10/13/2015 2:42 PM MX2 File 3KB
[ Document: =
& Music
(&) Pictures
B vid
% Computer
&, Local Disk (c)
s Lecal Disk (D3
File name: New2mo2 -
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6

Communication function between
MEXEO2 and applicable products

This chapter explains how to hold communication between the MEXEO2 and an applicable product to write or read
data.

Writing data to applicable product

The data created in the MEXEO2 can be written to the applicable product.

% Do not turn off the power of the applicable product while writing data. Doing so may destroy the
data

1. Click the [Data writing] icon in the toolbar. O

2. Select data to be written and click [OK].

3. Click [Yes].
Data writing starts.

[ ]

4. If the following message is displayed, click either [Yes] Warning =)
or [No] after checking the applicable product. & The actuator doss not match, or the resalution setting switch mode is different.
[Yes]: Writing data will be started. B e
[No]: Writing data will be discontinued. I[ = JI[ =

5. Afteritis completed, click [OK].

L1

Depending on the data, you may need to turn on the power supply again or execute Configuration.
Follow the instructions in the displayed messages.

e Restarting power ¢ Executing Configuration
Click [Yes] to execute Configuration.
If you click [No], execute Configuration manually.
Refer to p.23 for details.
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6-2 Reading data from applicable product

The data saved in an applicable product can be read to the MEXEQ2.

1. Click the [Data reading] icon in the toolbar. O

2. If the data is being edited in the MEXEQ2, a confirmation
message for saving the data is shown.
Click [Yes] to save the edited data or [No] not to save it.

If you select [No], the data under editing is cleared and overwritten with the data to be read.

3. Click [OK].
Data reading starts.

4, Afteritis completed, click [OK].
The screen shows the data that has been read.
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6-3 Verifying data
The data saved in the applicable product can be verified against the data displayed in the MEXEOQ2.

1. Click the [Data verification] icon in the toolbar. O

2. Select the data to be verified, and then click [OK].
Data is verified.
The results are displayed after the completion of
verification.

3. After checking the verification results, click [Close].

1

B Copying verification results

The verification results can be copied to the clipboard by clicking the right mouse button on the area that displays the
results and clicking [Copy results to clipboard]. The copied data can be pasted to other applications.

Nothing is copied if the data completely matches.

|20
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B Jumping to desired data from verification results

You can jump from the list of verification results to the edit window for the displayed data.

1. Select and double-click data that you want
to edit.
The window for editing the desired data
appears.

2. Click [Closel].

21§
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6-4 Resetting data of applicable product to factory default settings

The data saved in the non-volatile memory of the applicable product can be reset to the factory default settings.

m Do not turn off the power of the applicable product until the process is complete. Doing so may
\_/\/
destroy the data.

1. Click [Reset] from the [Communication] menu.

2. Select data that you want to reset to the factory default
settings and click [OK].

3. Click [Yes].
The data saved in the non-volatile memory of the applicable
product will be reset to the factory default settings.

[ ]

4. Afteritis completed, click [OK].

L1

Depending on the data, you may need to turn on the power supply again or execute Configuration.
Follow the instructions in the displayed messages.

e Restarting power e Executing Configuration
Click [Yes] to execute Configuration.
If you click [No], execute Configuration manually.
Refer to p.23 for details.

| 22



Communication function between MEXEO2 and applicable products

6-5 Executing Configuration

When the data of an applicable product is changed, the timing that the new value is applied varies depending on the
data. When a message prompts asking to execute Configuration, perform according to the following procedure.

This section explains using screen examples of the AZ Series Pulse input type, Pulse input type with RS-485
communication interface and Built-in controller type.

1. Click [Configuration] from the [Communication] menu.

2. Click [Yes].
Configuration is executed.

1

3. Afteritis completed, click [OK].

1

6-6 Going offline collectively

This is a method to end the operation function, monitor function, and test function collectively.
e Online: A state where any of the operation function, monitor function, or test function is enabled
o Offline: A state where all of the operation function, monitor function, and test function are disabled

To go offline collectively, click the "Disconnect (offline)" icon in the toolbar. ‘ = a ‘
{a
Clicking the "Disconnect (offline)" icon brings into a pressed state, causing to go offline. ‘ a II ‘
A

Executing any of the operation function, monitor function, or test function causes to go online
automatically.

23
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7  Printing data

This chapter explains how to print the set data and waveform measurement results.

7-1 How to print data

1. Click [Print] from the [File] menu.

2. Set the print item, print object and color, and click [Run].

3. At"Name," select a printer that you want to use for
printing and click [OK].

Data is printed. D

| 24
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7-2 Print preview

You can preview the print image on screen before printing it on the printer.

1. Click [Print preview] from the [File] menu.
Alternatively, click [Print] from the [File]
menu and, in the window that opens,
execute print preview.

When [Print] is clicked

The print preview window appears.

2. After checking the print image, click [Close].

25§
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7-3 Setting print options

1. Click [Page setup] from the [File] menu.

l ]
2. Click the tab of an option that you want to Page Setup
set. —
After the setting is completed, click [OK]. S — C_ox )
@ Portrait(Q) [ Title rowicol add I Cancel
() Landscape(A)
Paper
Size:(d) [Leﬂer v]
Souece:(S) [Fu ically Select v]
Print Preview(w/) ] [ Print
® "Page"tab
Set the orientation, paper, etc. to be used for printing.
—
: Margin | Header/Footer
Origrtation Print Setting I—IOK
@ Portrait(0) [ Title rowicol add Cancel
() Landscape(A)
Paper
Size:(Z) [Leﬂer v]
Souece:(S) [Automatically Select -
[ Print Preview(w).. | | Erint...

® "Margin" tab
Set the paper margin and header/footer positions.

|26



"Header/footer" tab
Set the header/footer.

Printing data
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8 Setup function

This chapter explains the functions mainly used to start up an applicable product.

8-1 Editing operation data

The operation data of an applicable product can be edited using the MEXEOQ2.

% Just changing the data in the MEXEOQ2 will not cause the data in the applicable product to change.
To change the data in the applicable product, writing data must be performed. Refer to p.18 for details.

1. Open the data edit window.

2. Click [Operation data] on the tree view.
The operation data edit window appears.

Operation data edit window

Refer to "5-2 Setting data in the data edit window" on p.13 for how to edit data and other information.

|28
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When the ARL Series is used, set the product ID in "Select axis" before editing the operation data.
To edit the data, the product ID and the ID selected in the axis selection of the MEXEQ2 must be

matched.

8-2 Editing parameters

The parameters of an applicable product can be edited using the MEXEQ2.
If "Data writing" is executed, the edited data can be written to the applicable product. Refer to "6-1 Writing data to
applicable product" on p.18 for details.

1. Open the data edit window.

2. Click a parameter group that you want to
edit from the tree view.
The parameter edit window appears.

Parameter edit window

Refer to "5-2 Setting data in the data edit window" on p.13 for how to edit data and other information.

29 ||
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8-3 Teaching/remote operation

A motor can be operated using the MEXEQ2. This function lets you check how the motor will operate before actually
connecting it to a host controller. Operation data can also be set using teaching function. Refer to p.44 for details.

The teaching/remote operation and I/O test cannot be executed simultaneously.

1. Click the [Teaching, remote operation] icon in the O

or
toolbar or click the [Teaching, remote operation]

short-cut button.
The teaching/remote operation window appears.

2. Click "Start the teaching remote operation.”

———1

3. Click [Yes].
The teaching/remote operation is enabled.

The teaching/remote operation requires
synchronization of the data under editing and the
data of an applicable product. When the data is not
synchronized, the following window appears. Select
a synchronization method and click [OK].

L1

When the above window appears, all the communications in progress are disabled. All the other
monitors in progress in other windows are also stopped. Resume monitor after synchronization is
completed.

4. To end the teaching/remote operation, unselect

"Start the teaching remote operation." :

|30
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8-4 Remote operation

A motor can be operated using the MEXEQ2. This function lets you check how the motor will operate before actually
connecting it to a host controller. Refer to p.44 for details.
This section explains using screen examples of the AR Series AC power input Pulse input type.

The remote operation and I/0 test cannot be executed simultaneously.

1. Click the [Remote operation] icon in the toolbar or
click the [Remote operation] short-cut button.
The remote operation window appears.

or

2. Click "Start the remote operation.”

—1

3. Click [Yes].
The remote operation is enabled.

The remote operation requires synchronization of
the data under editing and the data of an applicable
product. When the data is not synchronized, the
following window appears. Select a synchronization
method and click [OK].

[ ]

When the above window appears, all the communications in progress are disabled. All the other
monitors in progress in other windows are also stopped. Resume monitor after synchronization is

completed.

4. To end the remote operation, unselect "Start the

remote operation.” :
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8-5 1/0 test

1/0 signals of direct 1/0 and remote I/0 can be tested. Also, you can monitor input signals and cause output signals to
be output forcibly.

This function is convenient if you want to check the wire connection of physical I/O with the host controller and the
operation of network I/0.

m In I/0 test, you can forcibly turn on or off output signals. Consequently, other equipment connected

\_/\_/ . . .

to an applicable product may operate. Check the surrounding circumstances to ensure safety before
conducting this procedure.

The teaching/remote operation and I/O test cannot be executed simultaneously.

1. Click the [I/0 test] icon in the toolbar or click the [I/O test] or
icon.
The 1/0 test window appears.

2. Click "Start 1/0 test."

I

3. Click [Yes].
You can now perform /0 test.

1

4. Switch the ON/OFF status of input signals externally.
The check box [ of the corresponding "INPUT" is changed in the window.

ON (green) Conducting Active

OFF (white) Non-conducting Not active

5. When switching the ON/OFF status of output signals, click the check box [0 of "OUTPUT" in the window.

ON (green) Conducting Active

OFF (white) Non-conducting Not active

6. To end the I/0 test, unselect "Start I/O test."

—1
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9 Monitor function

This chapter explains how to check the status of an applicable product using the MEXEQ2.

9-1 Status, I/0 monitor

You can monitor the current status of an applicable product and the ON/OFF status of I/O signals.

1. Click the [Status, I/O monitor] icon in the O or
toolbar or click the [Status, I/0 monitor] short-
cut button.
The status, I/0 monitor window appears.

2. Click "Start the status, I/0 monitor."
The status, I/O monitor starts. :
The ON/OFF status of I/0 signals is displayed as
shown in the table.

Indicator 1/0 RS-4.85 .
communication
ON Conducting Active
(green)
OFF Non- .
(white) conducting Not active

The status, /0 monitor requires synchronization
of the data under editing and the data of

an applicable product. When the data is not
synchronized, the following window appears.
Select a synchronization method and click [OK].

[ ]

When the above window appears, all the communications in progress are disabled. All the other
monitors in progress in other windows are also stopped. Resume monitor after synchronization is

completed.

3. To exit the monitor, unselect "Start the status,

1/0 monitor." :
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9-2 1/0 monitor

B Internal I/0 monitor
All the 1/0 signals of an applicable product can be monitored. You can also check signals not assigned to direct I/O or
remote I/O.
1. Click the [Internal I/0O monitor] icon or
in the toolbar or click the [Internal I/
O monitor] short-cut button.

The internal I/0 monitor window
appears.

2. Click "Start the internal I/0 monitor."
The internal I/0 monitor starts. :

The ON/OFF status of I/0 signals is
displayed as shown in the table.

ON (green) Active
OFF (white) Not active

3. To exit the monitor, unselect "Start

the internal I/0 monitor." :
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H Remote I/O monitor

You can check the ON/OFF status of network I/0.
This section explains using screen examples of the network converter CC-Link compatible NETCO1-CC.

1. Click the [Remote I/0 monitor] icon
in the toolbar or click the [Remote I/0
monitor] short-cut button.
The remote I/O monitor window appears.

or

2. Click "Start remote I/O monitor."

The remote I/O monitor starts.
1:ARD-KD 2 3
The ON/OFF status of I/O signals is Owerme  [CNerhe  CJNerho Ofve20  ORYe28  ORYe30  CJRY03E
[ NET-INT [] NET-INS [CINET-INT [ Rrme21 [ Rrin+2)3 [ RY(n+3)1 [CIRY(n+3)8
1 1 [ NET-IN2 [ NET-INTO. CINET-IN2 I Rrn+2)2 CIRY(n+2)4 O RY+3)2 CIRY(n+3)A
dlsplayed as Shown n the table' [ NET-IN3 [ NET-INT1 I NET-IN3 CRvne23 O RY(n+28 CIRY3)3 CIRY(3B
O NET-INe O NET-ni2 ] NET-Ing O Rvine2e O RY(n+2)C O R Orvmac
[ NET-INS [ NET-INT2 [ NET-I5 [ RY(ns2)5 O RY(-21D O RY(n35 JRY(n-3D
MNET-ING ET-INTA NET-ING RY([n+2)6 RY(ns2E RY(n+3)6 RY(m3)E
) Remote I/0O (RS-485 EINEr-I CINECmts  CINETn7 Orve2r  Drviezr  ClRYea7  CJRVe3F
Indlcator . . 4 5 NETCO1-CC System Area
communication) Oreap R ORen0  [JRYS8 O- 0 O
[ Rvine4)1 0 RY(n-413 O RY(n-5)1 O RYm52 0- 0
. O RYim42 O RY(nA O Rvim5)2 CIRY5A O-
ON( g reen) Active O Rvea3 O mrinwi Ores3 Orvrse 0-
[ Ry(n+414 O RY(n+41C O RYin+5)4 ORYm5C [ o-REQ
I RYns4)5 Y(ne4)D CIRY(5)5 (n+5)D 0-
1 1 [ Ryns4)8. [ RY(n+4)E [CRY(n+5)6 CIRY(n+5)E - L
OFF (Wh Ite) Not active O Rins)7 O RY(n4F O RY(5)7 OIRY5F O- V
FX (NETCO1.CC to Master)
0:AZD-" 1:ARD-KD 2z
[] NET-0UTO [ NeT-OUTE ] NET-0UTO [INeT-0uTa [ RX(n=20 [ Rxn-2)2 RX{n+3)0 O Rx(m3e
[ NET-0UT [ neT-ouTS ] NeT-0UTY [ NeT-0uT [ Rxine2)1 0 Rxin-2)9 RX{n+3)1 O Rxm3e
ONeTou2  [NET-OUTI0  [JNETOUT2  [EINET-OUTI0  []RXne22 [ RX(ne2)A RX(r2)2 O Rer-aa
[ NET-OUT3 [] NET-OUTT1 [INET-OUT3 W neT-ouT11 [] RXn+2)3 [ rxin+28 RXIn+3)3 [IRXn+3)B
[ NET-0UT O NET-0UT12 I NET-0UT4 CIneT-out12 [ Rxin+2)C (n+3)4 CIRX(+3)C
[ MET-0UTS ET-0UTi3  [I NET-OUTS [COneT-0uTi3 O Rxin+21D (n+3)5 RX(+3)D
[ MeT-0UTE CINET-OUTH4 [ NET-OUTE [ NET-0UT4 [ Rxins2E RX(m+3)6 CIRX3E
[ MeT-ouT? OJneT-ouTis [ NET-OUTT [Jner-ouTis O RXn+2)F RX(ns3)7 Orxm3F
4 5 ystem Area
[ RX(ne0 [ RXinv O RXns5)0 CIRXr53 mcsuc - 0-
O Rxins)1 [ RXinv9 O RXms8)1 O Rxr52 (- O-
0 Rimei2 [ RX(-8 0 52 [R5 0- 0-
O Ree2 [ Rx(e-8 0 Rtime5)2 [ RXe-58 0- M cro
O Rt O RXinC 0 R4 CIRxm5IC =0 0O-
0 Rxine5 ] Rxinv10 0 x5 ClRxr5D O RERR 0- L4
O RX(n+46 [ RX(n+4E [ Rx(n+5)6 O rRxn+5E O sesr 0-
[ RXinet)7 [ Rxins4)F ] Rxne5)7 CIRxn5F 0- O- 3

The remote I/0 monitor requires
synchronization of the data under
editing and the data of an applicable
product. When the data is not
synchronized, the following window
appears. Select a synchronization

method and click [OK]. :

When the above window appears, all the communications in progress are disabled. All the other
monitors in progress in other windows are also stopped. Resume monitor after synchronization is

completed.

3. To exit the monitor, unselect "Start mr Ea)
f

remote |I/O monitor."

1:ARD-KD 2 3

[ NET-INO ] NET-Ng ] NET-IND [CINET-IN3 [ Rins20 CRm+28 CIRY(3)0 CRv3)3
O NET-NT [ NeT-Ng I NET-IN1 I NET-IN9. ORm+29 O RY(n3)1

[ NET-IN2 [ NET-INTD [ NET-N2 [JNET-IN10
[ NET-N3 [ NET-IN1 I NET-Ng [CINET-INT1

[ RY(n+3)2
[ RYin:

[ MET-IN4 O NET-INi2 [ NET-He [ NET-INi2 O RYin2)4
[ NET-INS [ NET-IN13 I NET-INS CInET-IN13 O rrin+20 [ RYin+3)5
O NET-ING. [ nNeT-IN18. I NET-INE CInNET-INT4 Orrin+2E OrRYin+36
[ NET-IN7 CINET-INT5 [ NET-I7 CINET-IN15 O RY(w2)F O RYe3)7 ORYm3F
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9-3 Remote register monitor

You can monitor the remote register status that can be read and written to via a network.
This section explains using screen examples of the network converter CC-Link compatible NETCO1-CC.

1. Click the [Remote register monitor] icon in the or
toolbar or click the [Remote register monitor] short-

cut button.
The remote register monitor window appears.

2. Click "Start remote register monitor."

The remote register monitor starts. :

The remote register monitor requires
synchronization of the data under editing and the
data of an applicable product. When the data is not
synchronized, the following window appears. Select
a synchronization method and click [OK].

[ ]

When the above window appears, all the communications in progress are disabled. All the other
monitors in progress in other windows are also stopped. Resume monitor after synchronization is

completed.

3. To exit the monitor, unselect "Start remote register

monitor’ —1
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9-4 RS-485 status monitor

You can monitor the RS-485 communication status of an applicable product.
This section explains using screen examples of the network converter CC-Link compatible NETCO1-CC.
1. Click the [RS-485 status monitor] icon in the toolbar or
click the [RS-485 status monitor] short-cut button.
The RS-485 status monitor window appears.

2. Click "Start RS-485 status monitor."
The RS-485 status monitor starts. | |

or

The RS-485 status monitor requires synchronization of
the data under editing and the data of an applicable
product. When the data is not synchronized, the
following window appears. Select a synchronization
method and click [OK].

[ ]

When the above window appears, all the communications in progress are disabled. All the other
monitors in progress in other windows are also stopped. Resume monitor after synchronization is

completed.

3. To exit the monitor, unselect "Start RS-485 status
monitor." [ |

37



Monitor function

9-5

Remote monitor

You can monitor the data sent and received between an applicable product and host controller.
This section explains using screen examples of the network converter EtherCAT compatible NETCO1-ECT.

1.

or

Click the [Remote monitor] icon in the toolbar or
click the [Remote monitor] short-cut button.
The remote monitor window appears.

Click "Start remote monitor."

The remote monitor starts. :

The remote monitor requires synchronization
of the data under editing and the data of

an applicable product. When the data is not
synchronized, the following window appears.
Select a synchronization method and click [OK].

[ 1

When the above window appears, all the communications in progress are disabled. All the other

3.

monitors in progress in other windows are also stopped. Resume monitor after synchronization is
completed.

To exit the monitor, unselect "Start remote

monitor." :
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10 Adjustment functions

This chapter explains how to adjust an applicable product using the MEXEO2.

10-1 Waveform monitor

The motor speeds and 1/0 signal status can be checked in waveforms.
Refer to p.48 for how to use the waveform monitor.

1. Click the [Waveform monitor] icon in the toolbar or or
click the [Waveform monitor] short-cut button.

The waveform monitor window appears.

2. Click "Start waveform monitor."
The buttons in the window are enabled, allowing you to prepare for measurement of the waveform monitor.

—a e ON—

I

Lli Ll

1 Measurement results are drawn in this area.

2 | The measurement conditions for each CH can be set. Refer to Step 3 for details.

Waveform measurement settings: Pos (trigger position), Level, CH, Mode, and Edge (detection condition)
3 can be specified.
For "CH," only those CHs displayed at@can be specified.

Run: This button is used to start measurement.
Stop: This button is used to stop measurement.

5 The measurement time range can be set.

The display method for CH3 and CH4 can be set.
6 | Scale:The display size can be selected from 1/1 (100%), 1/2 (50%), or 1/4 (25%).
Signal name: The signal name can be shown or hidden.

7 The measure for measurement can be shown or hidden. Also, the CH to be measured can be selected.
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The method to move the display position of the waveform drawn on the window can be selected. There
are the following two moving methods.

e Move the waveform per CH.
« Move the waveform of the CH selected in(2)simultaneously.

9 | The currently displayed waveform can be copied to the clipboard.

10 | The currently displayed waveform can be saved to an external file. Refer to p.50 for details.

11 | The setting for measurement can be loaded from "Favorites data." Refer to p.50 for details.

12 | The setting for measurement can be saved as "Favorites data."

The waveform monitor may synchronize the data under
editing and the data of an applicable product. When the data
is not synchronized, the following window appears. Select a
synchronization method and click [OK].

When the above window appears, all the communications in progress are disabled. All the other
monitors in progress in other windows are also stopped. Resume monitor after synchronization is

completed.

3. Set the measurement conditions for each CH.

v

O—
@Q—

1 Each CH can be shown or hidden.

2 | The display position of a waveform can be moved up or down.

3 | Thedisplay of measured signal can be inverted.

4 | Selecting this check box can drag displayed waveforms drawn in the window simultaneously.

5 | Thisis used to select a signal to be measured.

6 This is used to select a display scale for signals (CH1 and CH2 only). Using this setting in combination
with(@)can zoom in on signals.

7 The set offset value is added to the signal display (CH1 and CH2 only). Using this setting in
combination with(&)can zoom in on signals.

4, Click [Run].

The waveform measurement starts.

5. During measurement, click [Stop] to exit the waveform measurement.
If "SINGLE" is selected for Mode in Trigger, measurement automatically ends when waveform drawing ends.

6. To exit the waveform measurement, unselect "Start waveform monitor."

1
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11 Diagnosis functions

Using the alarm monitor and the warning monitor, you can check the causes of errors and troubles of an applicable
product.

11-1 Alarm monitor

The alarm records of up to ten most recent alarms starting from the latest one can be checked. Also, with the AZ
Series, the operation and the status of 1/0 signals, which were executed when the alarm generated, can be checked.
1. Click the [Alarm monitor] icon in the toolbar or click
the [Alarm monitor] short-cut button.
The alarm monitor window appears.

or

2. Click "Start the alarm monitor."
The alarm monitor starts. :
The current alarm and past alarm records are
displayed. Click the displayed alarm to show the
cause and measure for it.

The alarm monitor may synchronize the data under
editing and the data of an applicable product. When
the data is not synchronized, the following window
appears. Select a synchronization method and click
[OK].

[ ]

When the above window appears, all the communications in progress are disabled. All the other
monitors in progress in other windows are also stopped. Resume monitor after synchronization is

completed.

3. To exit the monitor, unselect "Start the alarm

monitor." :
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11-2  Warning monitor

The warning records of up to ten most recent warnings starting from the latest one can be checked.

1. Click the [Warning monitor] icon in the toolbar or

. . . or
click the [Warning monitor] short-cut button.
The warning monitor window appears.
2. Click "Start the warning monitor." I News* - vaming monicor =l
The warning monitor starts.
The current warning and past warning records are T 0aring ot recrt

displayed. Click the displayed warning to show the Wamig sy

. Code The warming message Cause
cause and measure for it. wrl e
e = \Warming ot presert parameter was outside the speciication
No.3 00 Waming not pressnt
Nod 00 Waming not presert
No.5 00 Waming not pressnt -
No§ 00 Waming not presert Measure
No.7 00 Waming not pressnt Set the "electronic gear” parameter comectly
s | o Waring ot precert e o el T T
No.9 00 Waming not pressnt
No.10. 00 Waming not presert
v ol :
Update | [ Clear the warming record.

The warning monitor may synchronize the data
under editing and the data of an applicable product.
When the data is not synchronized, the following
window appears. Select a synchronization method
and click [OK].

[ 1

When the above window appears, all the communications in progress are disabled. All the other
monitors in progress in other windows are also stopped. Resume monitor after synchronization is

completed.
. . n . 1
3. To exit the monitor, unselect "Start the warning i newz* - Warming monitor =
itor"
monitor. _
Warning Condition 00:Waming not presant
Code_| The waming message Cause
No.1 7 Bectrical gear setting emor The resolution set by the “electronic gear” -
parameter was outside the specification
No.2 0 Waming not present
No3 00 Warming not presert
No.d 0 Waming not present
No5 00 Warming not presert i
No.§ 0 Waming not present Measure
No7 00 Waming not presert Set the "electronic gear' parsmeter comectly
and cycle the power, so that the resolution will

No8 L Waming not presert: be between 100 and 10000 P/R
No9 00 Warming not presert
No.10 0 Waming not present

< | =
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11-3 RS-485 communication monitor

The error records of up to ten most recent errors starting from the latest one can be checked. Also, with the AZ Series,
the received data via RS-485 communication can be checked.

1. Click the [RS-485 com. monitor] icon in the toolbar
or click the [RS-485 com. monitor] short-cut button.
The RS-485 communication monitor window
appears.

2. Click "Start the RS-485 communication.
The RS-485 communication monitor starts. :
The current communication error and past
communication error records are displayed. Click the
displayed communication error to show the cause
and measure for it.

or

3. To exit the monitor, unselect "Start the RS-485

communication.” :
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12 Utilizing MEXEO2

This chapter provides some examples of utilizing the MEXEQ2.

Operating motor using the MEXEOQ2

A motor can be operated using the MEXEQ2. This function lets you check how the motor will operate before actually
connecting it to a host controller.

Operation data can be set using teaching function. Although there is no need to connect to a host controller, the
applicable product must be connected to the power supply.

Use the teaching/remote operation. The teaching/remote operation allows you to perform the following operations.
Positioning operation

Return-to-home operation

ZHOME operation

JOG operation

Teaching

e The teaching/remote operation and I/0O test cannot be executed simultaneously.

¢ Before performing this operation, set necessary data and write it to an applicable product.
e When the operation is started, connect the power supply to the applicable product and enable the
"teaching, remote operation." Refer to p.30 for details.

Positioning operation
You can operate the motor using the operation data written to the applicable product.

1. Set the number of operation data that you want to
execute in "Operation data #."

2. Click [Start positioning operation].

3. Click [Yes].
The positioning operation with the selected
operation data number starts.

Click [Stop] to stop the operation before completion.
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B Return-to-home operation

1. Click [Home operation].

2. Click [Yes].
The return-to-home operation starts.

[ ]

Click [Stop] to stop the operation before completion.

B ZHOME operation

You can perform return-to-mechanical home (ZHOME) operation.
1. Click [ZHOME operation].

2. Click [Yes].
The ZHOME operation starts.

[ 1]

Click [Stop] to stop the operation before completion.

B JOG operation

You can operate the motor either continuously or in steps of the specified minimum distance.
The method of JOG operation varies depending on the product.

JOG operation can be executed using the following buttons. The JOG operating speed can be changed using a
parameter.

Moves the motor in the negative direction at the JOG operating speed.
Moves in the negative direction at the speed of one-tenth of the JOG operating speed.
Moves the motor in the negative direction by the minimum distance.

: Stops the operation immediately.
Moves the motor in the positive direction by the minimum distance.
Moves in the positive direction at the speed of one-tenth of the JOG operating speed.
Moves the motor in the positive direction at the JOG operating speed.

:
:
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B Teaching
While operating the motor, you can set the current motor position as the operation data.

1. Change the current motor position either manually
or with JOG operation.
Do so while checking the "Command position | |
(CPQOS)" in "Driver status."
Use the JOG operation buttons to move the motor

with JOG operation.
JOG operation buttons él |
2. Select an operation data number at "Operation data
#"in "Teaching." L

3. Select an operation mode and click [Position set].
If you select "No setting for operation mode," the
operation mode set in the operation data number is
used.
The new position information is set to the selected
operation data number.

4. Click [Reflecting on the driver] to set the teaching
data to the applicable product.

5. Click [Yes].
The data is written to the applicable product.

L1

m Just clicking [Position set] will not cause to write to the applicable product. Be sure to execute
\/\/ . .
[Reflecting on the driver].

While the applicable product and PC are connected (online), you cannot edit data other than the
operation mode and position. Edit these data under disconnected condition (offline).
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Teaching software limit

Utilizing MEXE02

While operating the motor, you can set the current motor position as the software limit value.

1.
2.

Nt

Enable the teaching/remote operation.

Change the current motor position either manually

or with JOG operation.

Do so while checking the "Command position
(CPOS)" in "Driver status."

Use the JOG operation buttons to move the motor
with JOG operation.

JOG operation buttons él I

Click [Preset (CPOS—1)] to set a software limit value
in the negative direction.

Click [Preset (CPOS+1)] to set a software limit value
in the positive direction.

Click [Yes].

The software limit value is set.

When [Preset (CPOS+1)] is selected, the positive
software limit value is the command position +1.
When [Preset (CPOS—1)] is selected, the negative
software limit value is the command position —1.

Click [Reflecting on the driver] and then [Yes].
The data is written to the applicable product.

L1 [

L1

L1

Be sure to execute [Reflecting on the driver].

Just clicking [Preset (CPOS—1)] or [Preset (CPOS+1)] will not cause to write to the applicable product.
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12-3  Utilizing waveform monitor

Refer to p.39 for the basic usage procedure of the waveform monitor.
As examples of utilization of the waveform monitor, this section explains the following items using screens of the AZ
Series Pulse input type, Pulse input type with RS-485 communication interface and Built-in controller type.
e Zooming in on waveform data
Moving drawing positions of waveforms for multiple CHs simultaneously
Saving waveform measurement results as images
Saving waveform measurement results as data

B Zooming in on waveform data

You can enlarge and display part of the measured waveform data.
The following shows an example of zooming in on around the peak value after measuring the detection speed of
CH1.

1. Measure the waveform.
In this example, the detection speed of CH1

. Zoom in on the
is measured.

waveform peak

O

2. Select "CH1"in "Measure," and select the AV
check box.
The result shows the peak value of CH1 at
around 300 r/min.

3. Click [CH settings].
The CH settings window appears.
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4, In"Offset" of CH1, enter a center value onto
which you want to zoom in.
In this example, enter 300 (r/min), the
measurement result of Step 2, to zoom in on

around the peak value. :

5. Change "Scale" of CHT.
In this example, set the speed for each scale
on the vertical axis.

The waveform is zoomed in, centering on
the value entered as the offset value.

B Moving drawing positions of waveforms simultaneously

You can change the display positions by moving the waveform curves in the window.
This section explains how to move multiple CH curves simultaneously.

1. After waveform measurement, click the

button located in the upper right corner of
the waveform monitor window.

The button is changed to .

2. Click the CHs that you want to move &
simultaneously. 4}

When you want to move all of the lines on

. . CH!

the waveform simultaneously, click | aw |.
CH2
All of the CHs can be selected. 5

3. Drag the waveform curves in the window to CH4
move them vertically. 71 CHE
The selected CHs are moved simultaneously.
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B Saving setting conditions for measurement

The setting for measurement can be saved as "Favorites data."

1. In the waveform monitor window, click [Save favorites

y 4
dool. & A (2

2. Enter a data name and click [Save].
You can also enter a memo in the comment field.

B Loading saved setting conditions

The setting for measurement can be loaded from "Favorites data."

1. In the waveform monitor window, click [Load favorites

datal. ‘ ‘ ‘

~~

| =]
&)E
N

2. Select data that you want to load and click [Open].
The loaded setting conditions are applied to the
waveform monitor window.

B Saving waveform measurement results as images

The currently displayed waveform can be saved as a bitmap-format image.
1. In the waveform monitor window, click [Save o
waveform datal. (

2. Enter afile name, set the file type to the
bitmap format (*.omp), and click [Save].
The waveform is saved in the bitmap format.
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B Saving waveform measurement results in CSV format

The currently displayed waveform can be saved in the CSV format.

1. In the waveform monitor window, click [Save

waveform datal. ‘ ‘ ‘ !;' ‘ ‘ iﬁr

2. Enter afile name, set the file type to the CSV
format (*.csv), and click [Save].
The waveform is saved in the CSV format.

Checking wiring of applicable product

Using I/0 test, you can monitor input signals and cause output signals to be output forcibly. This function is
convenient if you want to check the wiring of I/0 signals and the operation of network I/O.

m In 1/0 test, you can forcibly turn on or off output signals. Consequently, other equipment connected

\A/ . . .

to an applicable product may operate. Check the surrounding circumstances to ensure safety before
conducting this procedure.

The teaching/remote operation and I/0 test cannot be executed simultaneously.

1. Click the [Test I/0] icon in the toolbar or click the AL @) or
[Test 1/0] short-cut button.
The test I/O window appears.

2. Click "Start 1/0 test."

—1

3. Click [Yes].
1/0 test is enabled.

4. Switch the ON/OFF status of input signals externally.
The check box [ of the corresponding "INPUT" is changed in the window.

ON(green) Conducting Active

OFF(white) Non-conducting Not active
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5. When switching the ON/OFF status of output signals, click the check box O of "OUTPUT" in the window.

ON(green) Conducting Active

OFF(white) Non-conducting Not active

6. To exit I/0 test, unselect "Start I/O test."

—1

12-5  Utilizing the warning function for when writing data

This function can be used only for the product that a desired name (user name) can be set to the motor or driver.
When writing the MEXEO2 data to the applicable product, setting the user name can prevent from overwriting the
data to a wrong product.

This section explains using screen examples of the AZ Series Pulse input type, Pulse input type with RS-485
communication interface and Built-in controller type.

| 52



Utilizing MEXE02

1. Click [Option] from the [Tool] menu.
The [Option] dialog appears.

2. Select the user name to be compared from
"Warning for writing data," and click [OK].

B When writing data

When writing data, if the user name is not same between the
MEXEO2 and applicable product, the following message is
displayed.

Click either [Yes] of [No] after checking the applicable product.
[Yes]: Writing data will be executed.

[No]: Writing data will be discontinued.
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12-6 Updating the firmware of applicable product

The firmware of the applicable products can be updated using the MEXEQ2.
This section explains how to update using windows/screens of the AZ Series pulse input type, the built-in controller
type, and the pulse input type with RS-485 communication interface.

e The update of firmware can be executed for the applicable products that [Firmware update] is
shown under the [Support] menu.

e Stop the motor before starting the update of firmware.
e Check on the Oriental Motor Website for the latest firmware version of applicable products.

1. Click on [AZ driver firmware update] from the
[Support] menu. | |

2. Click [OK].

3. Click [Yes].
Updating the firmware starts.

L1

¢ Do not turn off the power of the applicable product until the update of firmware is completed.
e Once the update of firmware is executed, the version cannot be returned to the previous one.

o If the firmware of the applicable product has already been updated, the following dialog box is
shown.

4. Afteritis completed, click [OK].

L1

The firmware version of the applicable product can be checked with the unit information monitor.

Even if the firmware is updated, the settings for the operation data and parameters before updating
have been retained.
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13 Troubleshooting

13-1 Checking error message

If the MEXEO2 has encountered a problem while running, a corresponding error message is shown in the window.
"Measures" may be displayed depending on the contents of the error message. Click "Measures" to display the error
details. Check the screen and appropriately deal with the issue.
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13-2  Frequently encountered errors

This section explains frequently encountered errors and measures required for them.

B Communication fails

During data reading, writing, monitoring and testing, the following error message may be displayed, and
communication may not start.

Example: When reading data

The problem may be resolved if you specify the settings in the procedure shown below.

1. Click [Option] from the [Tool] menu.
The "Option" dialog appears.

2. Click "When a motor stops without intending during
motor driving, please check it and then click [OK].
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If the problem persists after you take the procedure above, the cause may be one of the following. Take an appropriate
measure.

Exit the applications other than the MEXEQ2 before continuing the

1. Other applications are running epeEen

Exit the resident applications before continuing the operation.

For some types of applications, exiting them may not resolve
problems. In this case, use a PC on which the relevant applications are
not installed.

2.Too many applications stay resident

. . . o Take the measures 1 and 2 above.
3.The processing speed of PC is insufficient

o Refer to p.4 and check that your PC satisfies the system requirements.

B Communication timeout error occurs

If communication is not possible even when the applicable product is powered on and a correct communication port
is selected, perform the following procedure.

1. Click [Option] from the [Tool] menu.
The "Option" dialog appears.

2. Click "When communication time-out errors are
frequent, please check it and then click [OK].
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B Other window is communicating

At the start of monitor or test, the following error message may be displayed, and communication may not start.

Example: Performing waveform monitor

Other data setting window may be executing the communication function. While one window is executing the
communication function, other windows cannot use it. Check this point using the following procedure:

1. Click the [Window] menu.
A list of currently open windows is displayed.

2. Select another window to check if it is online.
If it is, click the [Offline] icon in the toolbar to clear the communication.

Editing cannot perform in communication

When editing data, the following error message may be displayed.

You cannot edit data while the communication function is executed. | ;
Click the [Offline] icon in the toolbar to clear the communication. A
Data can be edited.
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e Unauthorized reproduction or copying of all or part of this Operating Manual is prohibited.
If a new copy is required to replace an original manual that has been damaged or lost, please contact your nearest Oriental
Motor sales office.

e Oriental Motor shall not be liable whatsoever for any problems relating to industrial property rights arising from use of any
information, circuit, equipment or device provided or referenced in this manual.

e Characteristics, specifications and dimensions are subject to change without notice.

o While we make every effort to offer accurate information in the manual, we welcome your input. Should you find unclear
descriptions, errors or omissions, please contact your nearest Oriental Motor sales office.

o Orientalmaolor is a registered trademark or trademark of Oriental Motor Co., Ltd., in Japan and other countries.
Windows is registered trademarks or trademarks in the United States and other countries of Microsoft Corporation in the
United States.
CC-Link is a registered trademark of the CC-Link Partner Association.
EtherCAT® is registered trademark and patented technology, licensed by Beckhoff Automation GmbH, Germany.
Other product names and company names mentioned in this manual may be registered trademarks or trademarks of their
respective companies and are hereby acknowledged. The third-party products mentioned in this manual are recommended
products, and references to their names shall not be construed as any form of performance guarantee. Oriental Motor is not
liable whatsoever for the performance of these third-party products.

© Copyright ORIENTAL MOTOR CO,, LTD. 2014

Published in May 2025

- Please contact your nearest Oriental Motor office for further information.

ORIENTAL MOTOR U.S.A. CORP. ORIENTAL MOTOR ASIA PACIFIC PTE. LTD. INA ORIENTAL MOTOR CO., LTD.
Technical Support Tel:800-468-3982 Singapore Korea

8:30am EST to 5:00pm PST (M-F) Tel:1800-842-0280 Tel:080-777-2042

ORIENTAL MOTOR (EUROPA) GmbH ORIENTAL MOTOR (MALAYSIA) SDN. BHD. ORIENTAL MOTOR CO., LTD.
Schiessstral3e 44, 40549 Dusseldorf, Germany Tel:1800-806-161 4-8-1 Higashiueno, Taito-ku, Tokyo

Technical Support Tel:00 800/22 55 66 22 ORIENTAL MOTOR (THAILAND) CO., LTD. _}1|0+%513§J6a731n0361
ORIENTAL MOTOR (UK) LTD. Tel:1800-888-881 o

Blythe Valley Business Park www.orientalmotor.co.jp/ja
Central Bivd Blythe Valley P’ark, ORIENTAL MOTOR (INDIA) PVT. LTD.

lihull A i Ki Tel:1800-120-1995 (For English)
?;’l;L_?SSf_é% gzn(;ted ingdom 1800-121-4149 (For Hindi)
ORIENTAL MOTOR (FRANCE) SARL TAIWAN ORIENTAL MOTOR CO., LTD.
Tel:+33-1 47 86 97 50 Tel:0800-060708
ORIENTAL MOTOR ITALIA s.rl. SHANGHAI ORIENTAL MOTOR CO., LTD.

Tel:+39-02-93906347 Tel:400-820-6516
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